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Overview

The newly released Mac OS X (Panther) provides a stable, yet flexible foundation for meeting your needs.  From a user perspective, Panther offers new tools, functionality, and a visual interface for the Macintosh platform.  This help guide has been developed to help users learn the basics of Panther.

System Preferences

The System Preferences are the controls for your Macintosh.  Experienced Mac users will find the System Preferences similar to those that were found in the “old” Control Panel.  The Panther System Preferences are divided into five major categories: Personal, Hardware, Internet & Network, System, & Other. The Other system panel only appears if you have outside hardware installed that requires control preferences to be set.  For instance, if you install a multi-button mouse you may gain controls for controlling mouse functions. Individuals using public domain computers or non-primary accounts (such as students) may not have the privileges needed to adjust the System Preferences.

Personal Preferences

The panels in the personal preferences provide you a way to individualize the visual aspects of your Macintosh.  

Dock

This panel allows you to change the size, level of magnification, position, and effects of your Dock.

General

This panel allows you to change the appearance of buttons, menus, & windows.  It also provides controls for highlight colors, scrolling, number of recent applications and font smoothing for various monitor types.

International

This panel establishes your primary language, date, clock, number, and keyboard layout options.

Desktop & Screen Effects

The Desktop panel allows you to change the background of your desktop.  The Screen Effect panel controls the different built-in screen savers. It should be noted that screen savers are for aesthetic purposes only—with modern screens you don’t have to worry about screen burn.

Hardware Preferences

The panels in hardware preferences control the functioning of your Macintosh’s associated hardware.  This hardware includes: CD/DVD drives, monitors, keyboards, sound and more. 

CDs & DVDs

This panel allows you to tell your Macintosh how to handle both CDs & DVDs.

Displays

This panel gives you the ability to control your display resolution, colors, & arrangement.

Energy Saver

This panel controls how quickly your computer will sleep after remaining inactive.  Energy Saver is especially useful for laptop users trying to enhance battery performance.

Keyboard & Mouse

The keyboard panel controls how quickly your keys recognize repeat key strikes. This panel also allows you to activate Control keys to control your Mac’s menu systems. This is especially useful for individuals with limited mobility. The Mouse panel controls the functions of your mouse and/or track pad.

Sound

This panel controls your Mac’s alert, output, and input sounds.

Internet & Network Preferences

As indicated by its name these panels control your computer’s connections with the Internet and other networks.  Within this section of panels you can also control QuickTime applications and File Sharing options. If this is your personal Macintosh you may have to setup these system preferences. If you have already established a working connection then it is recommended that you not change these preferences. 

.Mac

This panel controls your .Mac and iDisk settings, as well as your default email and Web browser settings.

Network

This panel controls how your computer connects to other computers and the Web.  To see more on this section click on the Servers & Printers tab at the top of the screen.

QuickTime

This panel controls your QuickTime settings.  If you have difficulties opening QuickTime items you may have to change or update these settings.

Sharing

This panel establishes permissions to access your computer from other computers. Unless you have need to access files from afar, this setting is generally turned off.

System Preferences Panel

The System panels contain options for setting up user accounts, opening Mac classic, date and time, updating software, speech recognition, start-up options, and controls for universal access.  Again, these panels may not need to change if preferences are already established and working. 

Accounts

If you are the administrator of the computer you can add and change user options in this panel.

Classic

This panel allows you to start and stop the use of Mac OS 9, referred to as “Classic”.  For the most part, the new OS will know when the Classic version is required.

Date & Time

This panel establishes your computer's understanding of date and time.  You can control these settings as needed.  Most network-based computers have been established to gather this information from a network connection.

Software Updates

This panel controls a new utility that checks for software updates.  In this panel you can also view a log of previous installs.

Speech

A little known fact about Macintosh is that your computer accepts verbal commands to control specific functions.  This panel controls the speech recognition and speakable capabilities of your Mac.

Startup Disk

Within this panel you can select what Operating System (OS) you want your computer to open at start-up (OS 9 or OS X).

Universal Access

This panel gives you controls to make your Macintosh more accessible.  You can control zoom, coloration, visualization of sound queues, keyboard controls, and specific mouse controls.

Dock

What is the Dock?

The dock is a customizable multipurpose tool that keeps track of open applications, allows you to jump between them, stores icons of applications you use frequently, and allows you to quit applications.  This tool combines the functionality of the old Apple menu, Application menu, Launcher, and control strip.  If you look closely, you will see a divider line in the dock.  To the left (or on top) of this line are applications, and to the right (or on the bottom) of this line are folders, documents, and the trash.
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Using the Dock as an Application Launcher

The dock can be used to quickly launch applications.  Your computer will come with some applications already in the dock.  To open one of these applications, simply click once on the application icon. Once a program is running, you will see a small black triangle under or next to its icon in the dock.  Additionally, if you open a program whose icon is not in the dock, it will appear there while the program is running.  You can switch between open applications by single clicking their icons in the dock. 

Customizing the Dock

What to put in the dock

The dock is designed to make accessing all of your favorite programs and documents easier and faster.  You should place applications and documents you use frequently in the dock.  If you use a large number of applications on a regular basis, you might consider placing your Applications folder in the dock.  You will then have access to all of the applications on your computer directly from the dock.  You might also consider placing your Documents folder in the dock.  This will give you easy access to all of your files.  In the end, what you choose to put in the dock is completely up to you.

Adding to the Dock

Adding Applications to the Dock

There are two ways you can add programs to the dock.  The first is by dragging the application icon over to the dock.  The icons already on the dock will move aside to make room for your new icon.  Simply let go of the icon and it will remain in the dock.  Remember, you can only put application icons to the left of the divider and folder and document icons to the right.  The second way to add an icon to the dock is to open the application.  While it is open, its icon will appear in the dock.  Click the icon and hold down the mouse button (or Control-click).  A menu will appear.  Choose “Keep in Dock”.  The application icon will remain in the dock after you quit the program.  

Adding Folders to the Dock

You can add folders or documents to the Dock in the same way you add applications—simply drag the folder or document to the dock and let go of the mouse.  Remember, folders and documents can only be placed on the right (or bottom) of the divider.  You can then open a folder or document by single clicking it.  Additionally, you can view the contents of the folder by holding the mouse button down over it*.  You can then select a sub-folder or document to open. 

*Please note that the dock can only display up to 96 items in one folder.  Your documents are still there, but you will not be able to access some of them from the dock.  Try reorganizing your folders so that no folder contains more than 96 items.

Deleting Icons and Arranging the Dock

Deleting Icons

You can easily remove icons that you do not use from the dock.  Simply click on the icon and drag it away from the dock.  When you let go of the mouse button you will see a puff of cartoon smoke, and the icon will no longer be on the dock.  You can always add the icon to the dock again later, as removing icons from the dock does not delete them from your computer.

Arranging Icons

You can change the order of icons in the dock by clicking an icon and holding the mouse button down.  Then, drag the icon to a new spot on the dock.  The other icons will move aside to make room.

Using the Dock to Manage Applications

As already discussed, the dock will indicate which applications are open with a small black arrow below the icon (if your dock is on the bottom) or to the side (if your dock is on the side).  

The dock also gives you the ability to close applications without going to them.  If you click an icon and hold down the mouse (or Control-click), you will see a menu appear next to the icon.  Depending on the status of the application, you will have multiple options in the menu:

Quit: Select this to quit the application

Show in Finder: Select this to open a finder window with the location of the application.  This is useful if you are having trouble and would like to read the read-me file that came with the application.

Keep in Dock: This option only appears when you are using an application that is not already stored in the dock.  Select this to keep the current application in the dock permanently.

Force Quit: This option will only be available if the application is frozen or locked up.  Select this to force the application to quit without affecting other open applications.

Moving & Hiding the Dock

You can move the dock to the left edge, right edge, or bottom of your screen.  To change the position of the dock to the left side of the screen, go to the Apple Menu(Dock(Position on Left.  Follow the same steps to move the dock to other areas.  You can also move the dock by opening the System Preferences and choosing Dock under the personal settings.

You can choose to hide the dock when it is not in use.  If the dock is hidden, it will appear when you move your mouse to the edge on which the dock is located.  To turn hiding on or off, go to the Apple menu(Dock(Turn Hiding On (or Off).  You can also control hiding in the Dock Preferences window.

Using Keyboard Controls

You can use your keyboard to control some aspects of the dock.  Here are some common controls:

Option-[image: image2.wmf]-D toggles the dock between visible and hidden.  This will also move Internet Explorer windows out of the way if they are too close to the newly visible dock.

 [image: image3.wmf]-Tab cycles through the open applications in the dock.  Let go of the keys to go to the currently selected application.

Control-click opens the hidden menu next to an icon, allowing you to quit the application or show it in the finder.  If you hold down the option key as well, you will get the option to Force Quit.  This is useful when the application is "frozen" or not responding.

Finder

What is the Finder?

The Finder is an application program that gives you access to your applications, saved files, and networks.  For example, when you open folders from your hard drive, they open in a finder window.  You can also use the Finder to organize the contents of folders and empty your trash.  You can open the Finder by clicking on the desktop, or by selecting the Finder icon at the far left (or top) of the dock menu. The Finder has two components: the finder windows and their related functions, and the finder menus.

The Finder Menus

The finder menus allow you to jump to folders such as your Applications folder, empty the trash, arrange the contents of folders, add new folders, connect to servers, and many other things. 

Finder

Use this menu to empty the trash, open the Finder Preferences window, and access other services.  You can also make your hard drive visible on the desktop using this menu.

File

From the File Menu you can create a new folder, create an alias, move an object to the trash, and search your computer using the Find application.

Edit

Use the Edit menu to cut, copy, paste, select all, and rename objects.

View

The View menu can be used to change the document view in finder windows.  This menu can also be used to hide or customize the Finder toolbar. 

Go

The Go menu can be used to jump to various areas of your computer.  For example, this menu can be used to open a finder window with your Applications or Home folder visible.  This menu also allows you to connect to a server.  See the section on servers and printers for more information on this topic.

Window

This menu can be used to bring all finder windows to the front of your screen, bring all applications to the front, or zoom or minimize the current window.  Open windows are listed at the bottom of the menu.

Help

This menu can be used to access OS X's built-in help guide.

Opening & Closing Finder Windows

To open a finder window, go to the File menu and select New Finder Window, or go to the Go menu and jump to your Home or Applications folder.  Any folder you open from the desktop will be in a finder window.  

One new thing in Mac OS X is the colored buttons in the upper left corner of every window.  The red button is the close button.  When you move your mouse over it, an X will appear.  Click this button to close the window.  There is also a yellow button.  This button minimizes your window and stores it in the dock until you are ready to open it again.  What’s great about OS X is that the image you see in the dock is actually a miniature version of the window you closed, not a generic icon.  This makes finding the window later much easier.  The third (green) button is the zoom button.  Click this to make your window large enough to show all of the content.  Click again to return your window to its original size. Finder windows can be resized by dragging their lower right-hand corner.

Finder Window Toolbar
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[image: image7..pict]The Icon View

The icon view is represented by the                            symbol.  In this view, icons and names represent files and folders.  If the icons are overlapping or not in order, you can go to View (Clean Up.  You can also arrange your icons by going to View(Arrange(by Name, Date Modified, Date Created, Size, or Kind.  Double-click an icon to open the file or folder.  You can change the size of icons and text by opening the Icon View options.  Go to View(Show View Options.  In this window you can change your settings for the current finder window, or all finder windows.

[image: image8..pict]The List View

The list view is represented by the                           symbol.  In this view, your files and folders are listed by name.  You can change the order in which they are listed by clicking a column, such as date, to arrange them by date.  Double-click a name to open a file or folder.  There are also arrows next to the folders.  You can display their contents in the current window by clicking once on the arrow.  Click the arrow again to close the folder.  You can also change your view preferences for this window or all windows by going to View(Show View Options.  This window will allow you to change text and icon size, and alter the columns shown in this view, such as size, kind, date modified, and date created.

[image: image9..pict]The Column View

The column view is new to OS X and is represented by the                           symbol.  This view allows you to look into multiple folders at the same time.  Depending on the width of your window and columns, you can look at up to 10 levels of folders in one window at the same time.  The column view is very useful for navigating quickly between files and folders.  The last column will show you a preview of the file if you click the file name once.  As with the other views, you click twice to open a folder or file.  The highlighted item in each column will designate your path.
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Customizing the Finder Toolbar

You can customize your finder toolbar or remove it altogether.  First, open a finder window by going to File(New Finder Window. To hide the toolbar completely, go to View(Hide Toolbar.  To customize the toolbar, go to View (Customize Toolbar.  You can add a new icon to the toolbar by dragging it to the toolbar, as you would drag an icon to the dock.  You can remove an icon from the toolbar by dragging it off the toolbar.  You can also change the icons and text to text only or icons only to save space.  Click Done when you are finished and your finder toolbar will be customized and you will return to the folder you started in.  You can also add your own icons to the toolbar.  For example, while in the customize toolbar window, you could drag a document or program icon to the toolbar.  The finder toolbar is almost like a second dock. 

Organizing your Workspace

The best way to organize your files is through a hierarchical system of folders.  For example, a student may create a folder entitled “Spring Semester”.  Inside that folder might be folders for each of the student’s classes.  Inside each class folder may be a folder for class notes and a folder for papers.  Within the finder, you can easily create folders and rearrange files.  Mac OS X will try to place files you create in your documents folder in your Home directory.  To create a new folder within the documents folder, open a finder window, navigate to your documents folder, and go to File(New Folder.  A folder entitled “untitled folder” will be created.  Click once on the folder name and a cursor will appear.  Give the folder a name.  You can now drag files and other folders into this folder, or move the new folder into an existing folder.  The column view is especially useful for this.  Drag a file’s icon until it is over the folder.  The folder should be highlighted.  Let go of the mouse button and the file will be placed into the folder.

Servers & Printers

Server and Printer Overview

If you are an experienced Mac user you should know the Chooser no longer exists within Panther.  If you’re a new Macintosh user the Chooser means nothing to you.  Connecting to a server and a printer has never been easier or more stable.  As discussed in other sections, the core of the new OS is the ability to seamlessly connect to outside networks, including the Internet.  Panther provides a user-friendly interface for the sometimes complex task of getting connected.  This section of the help guide will take you through the basics of connecting to a network and establishing printer connections within Panther.

Getting Connected to the Internet

This information is fairly detailed and may be unnecessary for many of you.  If you need help connecting to the Internet from your computer, please consult the online version of this help guide at: http://talent.ed.uiuc.edu/tutorials/macosx/
Printing

Because Panther no longer has a Chooser, users will have to become familiar with the Print Center for establishing printers and setting up print jobs.  Running through the Common Unix Printing System (CUPS) actually makes connecting to a local or network based printer easier.  

To connect to a printer, either select File(Print (command - P) or open your Print Center by locating it in the Utilities folder within your Applications folder.

Establishing Printers

Generally there are two types of printing connections.  A local connection, which is a computer that is connected directly to your computer through USB, or a network based printer such as AppleTalk.  The next few sections will discuss how to establish a printer list.  

To add printers, open the Print Center and select Add. Then choose the type of printer to which you want to connect: USB, AppleTalk, Directory Services, IP Printing. For most people USB and/or AppleTalk will be the printer type.

USB Printers

USB Printers that have recognized drivers will be visible to your computer upon connect.  If the printer is older a print driver may be needed. For the most part, CUPS recognizes and provides drivers for most widely used printers.  If a driver is needed, go to the printer company's webpage and download the needed driver or drivers.  Installation will be the same as with any software.

Epson

http://www.epson.com/
Canon

http://www.usa.canon.com/
HP

http://www.hp.com/
Lexmark 

http://www.lexmark.com/
Xerox 

http://www.xerox.com/
Brother

http://www.brother.com/
Network Based Printers

AppleTalk

Most networks established to handle Macintoshes also choose to enable AppleTalk based printers.  By selecting Add(AppleTalk in the Print Center you will be able to browse your AppleTalk enabled printers.  Upon selecting the desired printer, set your Printer Model to Auto Select and click Add.  Most widely used printers will be recognized and added to your print list immediately.  If your computer does not add the printer to the print list please contact your local help desk. 

Directory Services

Directory services settings allow you to browse all non-AppleTalk printers available to your Macintosh.  Establishing a connection to one of these printers follows the same format as selecting a printer in AppleTalk. 

IP Printing

IP printing allows you to establish printing through any Unix or OS X print server.  To do this you will need to have the print server’s IP address.  If you feel this type of connection is necessary please contact your local help desk.

Setting Default and Deleting

After establishing the necessary list of printers you can set your most used printer as the default printer by selecting the printer then clicking Make Default.  To delete a printer from the print list select the printer and click Delete.

Printer Controls & PDFs

Printer Controls

Each individual printer has a printer control window.  To establish special functions with your printer explore these controls. 

Portable Document Format (PDF)

Any item that can be printed may also be saved in PDF format.  This function may be useful for those who are sending a non-editable document as an email attachment or for those who want to make a permanent copy without using paper.  We encourage you to explore this option.  See the Extras section on Preview and PDF Files for more information on creating PDFs.

Connecting to Servers

Panther provides numerous ways to connect or mount a network server or “disk”.  To connect to a server, go to the Finder and select Go(Connect to Server or use the shortcut key (command-K).  Upon opening Connect to a Server you will be able to type in the address for the desired server or browse your local network by selecting the triangle next to the At menu.

Browsing Networks

Most people will choose to browse the network to locate the desired server.  Upon opening the browse option (selecting the triangle next to the At menu in Connect to Server window) your computer will show you all of your network's available servers. Navigate through the network’s servers until you find the location to which you want to connect.  Double click the server you want to mount.  The server’s protocol will then initiate the necessary login screen and volume mounting options.  Login as needed and the server will be mounted on your desktop and in your finder view.  

Mounted servers will also be added to Recent Servers, creating a shortcut for the next time you need to mount the same server.  You can also add mounted servers to your Favorite Servers menu by clicking the Add to Favorites button.

Typing a Network Address

If prefer typing the address of the needed server you should know that Panther supports numerous network protocols, including AFP (Apple Filing Protocol) and SMB (Server Message Block).  To type in a server address you must define the needed protocol by typing afp:// or smb://; if you do not type in a specified prefix Panthers assumes the network is AFP based. 

FTP

Unlike on older Mac operating systems, you will not need a separate FTP client to send files to a server using File Transfer Protocol (FTP).  Simply go to the Go menu and type ftp:// to begin the address.  You can also use an FTP client, such as Fetch.  Fetch can be located and downloaded through the company’s website.  Additionally, most HTML editing software includes an FTP client as a feature for publishing a site.

Extras

Standard with the new OS X are a host of applications and utilities that make your digital life more enjoyable and productive.  There are also a lot of new applications being developed specifically for Mac OS X.  This section of the help guide will highlight a few of these tools.

Preview & PDF Files

Preview is an application that opens PDF documents and image files in a variety of formats. 

Saving files as PDF files

New with OS X, you can now save many documents, such as word documents or web pages, as PDF (portable document format) files.  These files can be opened using Preview or Adobe Acrobat Reader.  To save a file as PDF, go to File(Print.  Click the button at the bottom of the window that says, "Save As PDF".  Give your file a name and be sure the Hide Extension box is unchecked.  Then save it to a folder on your computer.  PDF files can be viewed but not changed.  They are also readable by both Macintosh and IBM computers, sidestepping compatibility issues when transferring files between platforms.
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iTunes

iTunes is a digital music player and a whole lot more.  With iTunes you can listen to your favorite CDs and turn your CD tracks into MP3s.  iTunes also gives you access to 290 Internet radio stations categorized by genre.  Use iTunes to organize your music and create smart playlists based on categories such as your personal rating of songs, their genre, or artist.  Create custom CDs and MP3 CDs that play back on virtually any CD/MP3 player.

For more information, or to download the latest version of iTunes, visit Apple’s website at: http://www.apple.com/itunes/
iPhoto

iPhoto is an application for importing, organizing, editing, and sharing all of your digital photos.  Importing your photos from your digital camera has never been easier.  iPhoto has software drivers for most popular models of digital cameras built right in.  Just connect your camera to your computer and start downloading.  iPhoto also allows you to enhance and crop your photos.  Use iPhoto to create a book of photos that you can print at home or have professionally printed by Apple.  Order prints, create an online slideshow, or burn your pictures to a CD all within iPhoto.

For more information, or to download the latest version of iPhoto, visit Apple’s website at: http://www.apple.com/iphoto/
iMovie

iMovie is an application for creating and editing digital movies.  Transfer digital video footage to your computer and build a movie using iMovie.  You can add special screen and lighting effects, a soundtrack, and chapter markers.  iMovie lets you cut out parts of scenes, and add still images to your movies.  Movies can be optimized for viewing on the Web, saved as QuickTime files, or transferred to a DVD using iDVD.

For more information, or to download the latest version of iMovie, visit Apple’s website at: http://www.apple.com/imovie/
Safari

Safari is Apple’s new web browser created only for the Macintosh.  Safari loads pages three times faster than Internet Explorer for the Macintosh, and has many great features such as a built in Google search, a bookmark library for easy organization, seamless downloads, and the ability to block those annoying pop-up messages.

For more information, or to download the latest version of Safari, visit Apple’s website at: http://www.apple.com/safari/
Sherlock 3

Sherlock 3 is Apple’s tool for searching the web, and it comes standard with Mac OS X.  Sherlock 3 goes beyond simple web searching by featuring channels that allow you to check the price of your favorite stock, perform a search on eBay, check movie listings at your local theater, check the status of a flight, look up a word in the dictionary, and more.

Other Extras

While this help guide highlighted some extra features offered through Mac OS X, other “extra” applications include iCal, iChat, iSync, TextEdit, Stickies, Chess, Address Book, Rendezvous, and many more.  

We encourage you to explore your hard drive or visit Apple’s OS X website at http://www.apple.com/macosx/ for more information.
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